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Hard function

keys have

Red/Yellow

status LEDs

To access system administrator tools and 

counter information

Ready Not Ready

Simplified display magnifies fonts 

for easy viewing. See page 2 for 

example

Understanding Your Ricoh Control Panel
The program button allows you to store 

frequently used job settings and screen 

display defaults

Clears screen to default 

settings

Allows user to 

interrupt job in 

progress for new job

8.5” Full Color W-VGA Screen



Color Copier Display Panel

Simplified Display

Key color is only 

available in simplified 

display mode.

Paper tray status.

Frequently used 

reduce/enlarge ratios. These 

can be adjusted to suit users 

needs.

Finishing options. Sort, Stack, 

Staple and punch.

Short cut 

keys. Register 

keys in user 

tools “General 

Settings”

Batch & Mixed 

Originals.

Extended feature options including; margins, stamps, 

page numbering, covers & slip sheets. 

Specify color mode 

and quality. Confirm current settings.

Black & White Display

Finishing options may be added to this screen.



Copying Documents

Place Originals in the document 

Feeder

Adjust paper guides

Remove paperclips, staples or other loose objects before placing originals in feeder.  Be sure to 

straighten bent or curled edges
If using the Glass Platen, Lift the lid and place documents face 

down on the glass at the position of arrow regardless of size

Select any additional copy settings

Press original document type, i.e. Text, Text/Photo, Photo, etc.

Press [sort] to collate document (if not highlighted)

Enter any finishing options

Enter desired number of copies

Press [Sample Copy] copier will print one completed set and 

prompt you [Suspend] to cancel job or change settings

[Continue] if job is correct to complete remaining copy sets

Or press START to skip [Sample Copy]

Note:  When copying from the glass and requesting multiple copies, 

press the # key after feeding your last original to release the 

additional copies



Copy Enhancements
Select an original type that is suitable for your originals to 

enhance 

your copies.

There are five original types available:

Text

For originals that contain mainly text or printed characters.

Text / Photo

For originals that contain both text and photographs or 
pictures.

Photo

For Photographs or pictures choose from the following types.

• Glossy Photo: 

• Use when copying developed photographs

• Printed Photo: 

• Use when copying photographs or pictures that are 
printed on 

• paper e.g. magazines)

• Copied Photo: 

• Use when copying copies or originals generated by color 
copiers

Pale

For originals that have lighter lines written in pencil, or faintly 

copied slips.

Generation Copy

For originals that are copied repeatedly. The copy image can 

be reproduced sharply and clearly

Auto Image Density is highlighted

Press the Right or Left arrow to lighten or darken  

document

Press [] or [] to adjust the image density

Select your Original document type

You may also select the [Auto Density] option 

to further lighten or darken your document 

settings.



Sort/Stack & Rotate Sort Output
SORT Rotate/Sort – the machine assembles copies as sets in sequential order.  Use [Sort] when 

placing multiple page document to maintain page order - Same as [Collate].  When a finisher is installed 

with the device the machine will output the document in the Sort/Shift Sort order, separating the first set 

from the next set.

STACK – groups together copies of each page in a multi-page 

original.  Use Stack when setting multiple pages in the document 

feeder and requiring the same copy number count per page to be 

stacked.   

ROTATE SORT– Use Rotate Sort when your machine does not have 

a finisher to keep jobs separated .  To use this option you must have 

one paper tray loaded with 8.5x11 paper in landscape orientation and 

the other tray loaded with 11x8.5 portrait and select this option from 

the finishing mode or from the short cut menu on copier screen.



Stapling Documents
1.  Place Documents in the document Feeder

2.  On bottom of touch screen  - select the staple 
position that match your job output.

– Select Top Left (straight)

– Top Left Slant

– Bottom Left (for landscape documents fed through 
feeder in portrait orientation)

– Double Staple Left (portrait Orientation)

– Double Staple Top (landscape orientation)

– Booklet stapling (for booklet folded at center 
stapling)

3.  Press [OK]

4.  Press [Start]

2.  Select desired staple position

3.  Press [OK]

4.  Place documents in feeder

5.  Press  [START]

Note:  The number of pages stapled and stapling positions will vary  by 

machine model type and type of finisher installed. 

Single Slant Top
Double LTR

BOOKLET CENTER

SADDLESTICH

Double Ledger



2 & 3 Hole Punch



Duplex Copying (2 Sided Output)
Place Originals in Feeder

Landscape orientation or

Portrait orientation

Press OK

Enter desired options

Select copy count

Press START

Select

or

You can select these 

options from the main 

copier panel

Select



Copying Mixed Originals

1. Place Originals in the Document Feeder
Place the smaller sizes at the top of the stack as shown in the image   

Adjust the Side Guide flush against the largest original. 

Ensure that the right edges of all the sheets are aligned against the       

right side guide   . 
Ensure that all originals are lying face up. 

2.  Check the condition of the paper stack: 
All sheets should lie flat, with no curled or bent edges, 

Paper should be clean and feel dry to the touch, 

Attachments such as staples, tags or tapes must be removed. 

3. Press [Special Original]

4. Press [Mixed Sizes] then touch [OK]

5. Select any additional  options
3. If there are multiple  paper sizes you must either have all the 

sizes in different paper trays, or select the size paper you want 

them all to be or  they will output al the default auto paper select.

6. Enter desired number of copies

7. Press [Start]

8. Press [Clear Modes] key when you have 

finished. 
Selecting Duplexing must all be output on the same size.

This will return the document feeder to normal copy mode ready for the 

next user. 

Acceptable sizes in Inch:11" x 17“    ; 8½" x14"  ; 8½" x 11"  ;5½" x 8½"  



Create Margin

• Reduces the image to 93% of its original size and places the reduced image at 
the center By combining it with the Reduce / Enlarge functions, you can further 
increase a margin.

• 1. Press [Create Margin].

• 2. Select the reproduction ratio, if necessary.

3. Press START



Reduction/Enlargement

Select the option that matches your output

Place originals, Press START



Directional Size Magnification%
Use this feature to enlarge a document by placing percentage proportions in the horizontal and 

vertical fields.

Place document on platen glass

Press [Reduce/Enlarge]

Press [Direct. Mag. %].

Press [Horizontal)

Enter the desired ratio with the number keys, and then 

press [     ].

Press [Vertical].  

Enter the desired ratio with the number keys, and then 

press [    ].

Press [OK] twice.

Place the originals, and then press the [Start] key.



Edit/Stamp or Edit/Color Tab
Options

Vary by machine type and hard drive installed

Edit Color –

erase color, change or adjust color

Scan Position -

Used for moving copy image up or down on page

Margin Adjustments –

used to move margins for hole-punching, stapling or 

binding

Stamps –

used for background numbering, page numbering, 

watermarks, date stamping

Erase –

used for cleaning edges and borders, page centers

Edit Image –

used to replicate images, center images, invert images or 

duplicate images

Copy Quality –

used to adjust contrast and image background



Designate
Use this function to have certain pages of your original copied onto designation sheets or to insert a 

designation sheet for each page specified.  Before using this option you must set up the paper trays under 

paper tray settings.

Copy Blank

Press [Cover/Slip Sheet].

Press [Designate / Chapter].

Select [Designate: Copy] to copy designated 

page on the designated number page or
Press [Designate: Blank]. Not to copy 

anything on the specified page.

Press the key to select the chapter number.

Enter the page number of the first 

chapter using the numbers key, and then 

press the [#] key.

You can continue to specify additional 

page location numbers, up the 20 

locations may be selected.

After making all settings, press [OK] 

twice.

Press [Start] or [Sample Copy].



Preset Stamp

Allows users to place a watermark on documents being copied.  Users

Can choose stamp option, placement, size and density.  Users and also 

choose to place on first page only or on all pages being copied.  If using

A color unit, these options may be printed in color, on units with 

60+ page speeds have the option to create a desired stamp.

(Options may vary by machine types)



Image Repeat

Allows users place a single page on the glass and have the 

image repeated multiple times on a single page

Place image on glass

Press [Edit/Stamp]

Press [Edit Image]

Press [Image Repeat]

Press [OK]

Press [Reduce/Enlarge]

Press [Numbers Key]

Enter the reproduction ratio

Press [OK]

Select the paper size

Press [Start]

4 Repeats (50%)

8 Repeats (35%)

16 Repeats (25%)



Image Repeat

Original:,51/2 × 81/2 /Copy paper: 81/2 × 11  , or Original: 51/2 × 81/2 /Copy paper: 81/2 × 11 Original: 51/2 ×

81/2/Copy paper: 81/2 × 11, or Original: 51/2 × 81/2/  Copy paper: 81/2 × 11  

This feature allow you to take an original image and copy the image repeatedly on the same page.

Select the size of copy paper and the reproduction ratio.

Press [Edit/Stamp] Key

Press [Edit Image] key

Press [Image Repeat] key

Press [OK]

Press [Reduction/Enlargement] 

Enter the  Percentage amounts to repeat  the image on 

the page.

See examples for original sizes  below:-

4 repeats 50%

8 repeats 35%

25 repeats  35%



Margin Adjustment

Allows users to move the margins of a document being copied

for better placement of documents being copied, i.e. used to 

move the margins to the top, bottom, right or left of the page.  When 

using this option, the system does not reduce the image being copied

Therefore users must have adequate blank space when moving

Images. 



Document Centering

Note:

You cannot use the bypass tray 
with this function.

You can make copies with the image moved to the center of the copy paper.

Place  the document

Select the paper size.

Press [Edit / Stamp].

Press [Edit Image].

Press [Centering].

Press [OK].



Double Copies

• Press [Edit / Stamp].

• Press [Edit Image].

• Press [Double Copies].

• Press [OK].

• Select the paper size.

• Enter desired number of  copies

• Press [Start]

Place Original in Document or lift the lid and place face down on Glass Platen

Original Feed          Copy Output orientation



Edit/Stamp [Scan Position]

Allows users to adjust image (books) being

copied on the glass for better image

placement output without moving the document.

Use directional arrows to move the image in the

Desired Direction. users can elect to move

image on both sides of a page.

Place image on Glass

Press [Start]

Review output but do not move 

image

Press [Edit/Stamp]

Press [Scan Position]

Using directional arrows, move the 

image in the desired direction  and  

them press [Start]

Repeat as necessary until desired 

placement is made.



Edit Stamp/Edit Color [Erase]

Allows users to clean edges, borders, centers of documents being copied.

Users can use feature to clean single or multiple pages.  Single or multiple 

Edges may also be selected for a cleaner output of your documents



Page Numbering

Allows users to keep track of documents being copied for projects, etc. Users can choose numbering 

Sequence and  position of placement of numbers. 

Place  Documents in Feeder

Press [Edit /Stamp]

Select [Stamp]

Select [Page Numbering]

Press [Change] >Select [Page Numbering] Format>OK

Press Change (opposite side) Select  Page Number Placement>OK

Touch [First Printing Page] >indicate page to start number sequence

Touch [Last Number]>Enter information

Touch First [Printing Number] >enter information

Touch [Total Pages] >enter information

Select any other finishing options including the desired number of copies

Press [SAMPLE COPY] or [Start]

Page Number Format
Number Page Position

Starting Page, Starting Number 

and Ending number,



Date Stamp

Place documents in feeder or on glass platen

Press [Edit Stamp] or [Edit color]

Press [Stamp]

Press [Change Format], select desired format, 

Press [OK]

Press [Change] Select desired stamp placement, 

Press [OK]

Select [First Page Only] or 

Select [All Pages], 

Press [OK]

Press [Start]

Allows users to date stamp documents being copied for time sensitive documents, e.g. projects, deliver tickets, etc.  

Users can select different formats, stamp placement and if stamp should be place on front page ONLY or all pages 

.



Dup./Combine/Series

Full menu for short cuts on panel

Duplex – 1 sided+2 Sided

2 Sided+ 2 Sided

Combine – Combine multiple pages on single pages 

with options for 2 sided or single sided output and options 

of placing 2, 4, 8 or pages on a single page.  Users can choose 

different size pager for output.

Series – output documents from 2 Sided to 1 Sided

Copy 2 face forwarding pages of a book to 2 single pages.

Book – Create a magazine output (use booklet for 4 page output) use

Magazine for 5 or more pages.  When the booklet finisher is installed, 

Users can choose to have the job stapled and folded.

Use to copy 2 face forwarding pages of a book as a duplex output.

Default Screen 

Settings



Combine Pages

Some of these options are available from 

the main copier panel.  You cannot use 

the Bypass tray with this option.

Use this option to combine multiple single pages or 2 sided pages  for multiple pages copied on each side of a 

page.  Originals can be copied in portrait or landscape orientation.



Cover/Slip Sheets

Allows users to add covers, slip sheets, chaptering of documents and page inserts 

of different color paper.  Users can choose to insert blank pages or copy info on pages.



Adding Covers

To set the Bypass tray as the 

cover paper source:-

Press "User Tools" 

Select "System Settings" 

Select the "Paper Size" Settings" tab 

Select "Bypass" 

Select "Display" 

Select "Cover" 

Select "Mode Selected" 

Select "OK" 

Press "User Tools" again to exit

On the main screen:-

Select "Cover/Slip sheet" 

Select "Front Cover" 

Select "Blank" or "Copy" 

Press "OK" 

Set the paper for the cover sheet on the bypass tray 

For 2 sided covers select "Duplex" 

Set the originals on the document feeder

Select any additional options

Enter desired number of copies

Press Sample Copy

Press “Continue” if sample set is correct.

To change between 1 and 2 

sided covers:-

Press "User Tools" 

Select "Copy Features" 

Select "Page Format" 

Select "Cover Mode" 

Select 1 or 2 sided covers 

Select "OK" 

Press "User Tools" to exit 



Odd sized books may require some manual adjustments

Book Copying
Place open Book on Glass Platen 

Press [Dup./Combine/Series ]button

Select [SERIES] button

Press [Book - 1 sided] for single pages

Outputs 2 single pages for the right and left pages

Press [OK]

OR

Press  the [BOOK ]button

• Select [BOOK TO 2 SIDED]
– Copies the left and right pages and place front and back to a single page

– Press [OK]

Press Page size Paper tray

Enter desired sets

Press [Start]

•

  
Book 1-Sided

Book 2-Sided



Booklets & Magazine Modes
1.  Place all originals in ADF face up, portrait orientation or Landscape orientation

2.  Select [Dup./Combine/Series]

3.  Select [Book]

4. Select [Magazine] *
4. 1 - Sided for Simplex originals or 

5. Magazine 2 - Sided for Duplexed originals

5.  Touch [OK] twice

6.  Select [Edit/Stamp]

7.  Select [Centering]

8. Select [OK]

9.  Select the [Paper size] for output

10.  Enter desired number of sets

11.  Press [Start]

Optional

Press [Sample Copy] to preview job before running multiple sets

1 4

2 31 2

3

1 2

5 6

3 4

7 8

4
Use [*Booklet] mode for 4 page originals

Use [*Magazine] Mode for 5 or more page originals

1

4



Using the By-pass Tray

2.  Place copy paper in tray

Adjust tray paper guides to 

fit paper size

3.  On copier panel press the # key

4.  Press Paper Type, Select 

Paper option, Press OK
6.  Press OK

7.  Place originals, enter desired number of copies, press START, Press Clear Modes

5.  Press Paper Size



How to Program a Preset Function

1.On the initial scanner screen, make the settings you want to 

set as default.

2.Press [Program].

3.Press [Program as Defaults].

4.Press [Program].

5.A confirmation screen appears. Press [Yes].

The current settings are set as defaults, and then the initial 

screen reappears.

Note:

•To restore the initial screen's original default settings, press 

[Restore Factory Defaults].

•Default settings for the initial screen can be registered for 

normal screens and simplified displays respectively.



TAB Copying

Set tab stock  so that it will 

be fed  from the side without 

the tab edges first.

Adjust the back fence 

position so that the tab sheet 

holder will fit the tab stock. 

To Copy Tabs

Place the Tab Copy Originals in the Document Feeder

Select the Paper Tray containing the Tab Paper (tray 2 or tray 3)

Press START



Using INTERUPT Option

Use the INTERUPT function when you want to interrupt a long copy job, to make urgently needed 

copies. 



Sample Copy

Screen settings will change and display  “continue” or Suspend.

Use this option to check the copy settings before making a 

long copy run.  

Place originals

Select any other necessary functions for copy job

Enter number of desire copies

Instead of [START] press [Sample Copy] key

-One set is delivered as a sample

If  Sample Copy is acceptable, press [Continue]

-The number of copies made is the number of copies 

requested minus the proof copy.

If you press [Suspend] after checking the results, return 

to step 1 to adjust the copy settings as necessary.  

-Depending on the combination of functions, you may 

not be able to change some settings.

You can press [Sample Copy] again or press [Start] to 

output the job

Note:  This feature can only be used when [sort] is 

selected.  This feature is not available from the 

[Simplified screen].



Job Preset

New 

Job



Simplified Display
Pressing  the Simplified Display button will cause letters and 

keys to be displayed at a larger size, making operations 

easier.

To access the [Simplified Display]

Press the Simplified Display on the Main Screen

Display s the basic copier functions

Finishing options may be added to this screen for ease of 

use.  Not all functions are available with this screen.

Key color is only available in simplified display mode.



Accessing Document Server

From Copy Panel – Select Document Server Option

Used for storing documents for easy access, confidential printing etc.



Document Server Usage

Documents may be scanned or 

Printed to Document Server for:

-Confidential Printing

-Print and Hold

-Sample Printing

-Forms printing

-File Merge (different types)

-Electronic Distribution

-HIPPA Compliancy

-Label Printing

-Cost Savings



Document Server DisplaysList view Preview document

Edit user & file Info

Print one or multiple pages 

of a stored document

Search by user name

Search by file name

Displays scan options

Displays printing options of a 

stored file

Preview

File Management

Delete File

Print Specified Page

Details

To Printing Screen



Scan a Job To Document Server

Shows a list view of documents stored in Document Server.  You can also view documents in the thumbnail view to see the first page of the document stored.

Place document in feeder or on the glass

Press [Document Server]

Press [Scan Original]

Select any appropriate document options

Touch [User Name] enter your name or select from 

list - optional

Touch [File Name] delete the default name and 

enter new document name using keyboard

Touch [Password] enter a password for your 

document if required - optional

Press [OK] after each entry

Press [Start]

Document is stored

Continue the above process for each additional document you wish to store



Print a Job From Document Server

Shows a list view of documents stored in Document Server.  You can also view documents in the thumbnail view to see the first page of the document stored.

Press [Document Server]

Select the document you wish to print

Press [Start]

To [Sort], [Staple] or add any additional print 

options

Press the [to Printing Screen]

Select any appropriate feature

Enter the number of desired copies

Note:

If document is password protected a password is required  

before a document can be accessed

If  only a single copy of the document is required with no 

finishing options, press [Start)

Document is Printed

Continue the above process for each additional document you wish to Print.  

Multiple files may be selected to be printed.  If you select multiple files and 

press the to printing screen, files will be merged.  This action vary from 

machine to machine.

To Printing Screen



Delete a Job From Document Server

Shows a list view of documents stored in Document Server.  You can also view documents in the thumbnail view to see the first page of the document stored.

Press [Document Server]

Select the document you wish to delete

Press [File Management)

Press [Delete File]

Confirm deletion [Yes]

File is deleted

Note:

If document is password protected a password is 

required before document  can be accessed

Continue the above process for each additional document you 

wish to Delete.  Multiple documents may be selected to be deleted.

Delete File

Delete File



Printing

How to Print Documents from your PC



Printing a Document

Open your document to Print

Select [File>Print]

Select the Ricoh Print driver

Enter desired number of copiers

Press [OK]

To add any finishing options to the document

Open your document to Print

Select [File>Print)

Select the Ricoh Print driver

[Staple, hole punch or duplex]

Press [Properties]

Select the desired finishing option

Press [OK] repeatedly to print



Printing To Document Server
Open your document to Print

Select [File>Print]

Select the Ricoh Print driver

Press [Properties]

At [Job Type] open the drop down window 

and choose [Document Server]

Press [OK]

Press [Details]

Enter user Information:

User ID (if applicable) or leave blank

File Name

Password (if applicable)

User Name

Press [OK] repeatedly to print



Printer Properties
Job Type

Locked Print: Temporarily holds print jobs in the memory until a valid password is entered at the control 

panel. Files are automatically deleted from the system HDD after printing.

Hold Print: Temporarily holds multiple print files in the memory until selected. Does not require the user to 

enter a password.

Sample Print: Outputs the first set of a multiple-set print job so that output settings can be checked for 

accuracy prior to printing the entire job.

Stored Print/Store and Print: Identical in functionality to Hold Print, except files are not immediately deleted 

after printing. Store and Print enables users to print files immediately while simultaneously storing data. 4-8 

digit password is optional.

Document Server: Sends files directly to the document server for storage and printing at a later date.



Accessing Confidential Documents

Press Printer to access 

the list of stored files from 

your computer as listed 

on right:-



Retrieving Confidential Document at Copier
Printer must be online to be 

able to submit work via 

desktop

Main Display

Print Jobs List

Highlight 

file and 

select 

print.

If you submitted 

your print job via 

the “locked Print” 

feature, you will 

now be prompted 

for your password.

At Copier Panel

Press [Printer]

Press [Print Jobs]

Select the [Locked Print Job List]

Select the job you want to print

Press [Print] enter password 

Press [Start]

Document will print and erase! 

Note: You cannot makes changes or reprint this job.



Scanning Documents

From Copier Panel, Select Scanner – Place the documents to be scanned 

in the Document Feeder or on the Platen Glass and Select the 

appropriate options for your Documents where necessary.



Scanner Display Panel

Preview scan before sending.

Select tabs to switch between 

email and folder scan 

destinations.

Add email message.

Add subject heading.

Add security features to document 

i.e. encryption & signature.

Set up notification when 

your email is opened.

Set sender from list of 

registered users.

Check file status.

Select file stored in the 

document server.

Set resolution, scan size & 

scan type.

One or two sided original.

Set file types between multi 

and single page PDF, TIFF 

and JPEG* 

* JPEG scanning in single page mode only.

Program email destinations into 

one touch buttons. Groups and 

individual addresses can be 

programmed.

For manual email entry



1. Place originals in Feeder or on Glass Platen

2. Select desired destination[s]  e-mail or Folder Tab

3. Select any additional document enhancements

1. Select [Scan Settings], select original document Type, Press [OK]

2. Press [Resolution] select desired resolution, Press [OK]

3. Press [Scan Size] select document size or [Mixed size], Press [OK] 

4. Press [Original Feed Type] if originals are [2 sided or Duplexed] 

5. Select original orientation – if applicable

6. Select [Batch] if feeding from feeder and glass or originals exceed document feeder limits.  If using the glass 

platen, press the # key after last page is scanned

4. Press [File Name/Type] Name your document and select [File Type] if necessary

5. Press [Start]



User selectable options may be changed prior to scanning for 

better document output





Scanning Options
Change File Type based on 

Document Type
Drop out Color from Documents



Viewing the Job at your Desktop



Faxing Documents From Copier



Select Stored Fax Destination(s) or enter a New Destination using the 

Numeric Key Pad on Right Side of Copier

Use to Store a FAX Destination

Users can send single document to one or more users simultaneously.  Use

The Original Feed type to select 2 sided when originals are 2 sided and copier

Will scan and send both sides. When Networked, users have the option of 

Installing the LAN fax driver for faxing documents from the desktop with fax 

Covers and other options.  Confirmations can print automatically, selectively, 

for errors only or off.



Enhanced Fax Capabilities

• ■ Cover Sheet Editor: Users can create personalized fax cover sheets that may contain the company logo, slogan,

• To, From, and Comments areas. Cover sheets can be edited and saved to users’ PCs as a fixed form.

• ■ Address Book Import/Export: Data can be extracted from or poured into other LAN-Fax drivers. This removes

• customer resistance to switching from existing LAN-Fax solutions to Ricoh’s, as the primary task of manually

• re-entering address book entries is now automated.

• ■ Transmission Status: Transmission results can be checked via SmartDeviceMonitor or Web Image Monitor, so

• users are assured faxes reached their destination.

• ■ Preview: Users can check how the document will appear on paper directly from the LAN-Fax driver.

• ■ Duplex Printing: Inbound fax documents can be printed on both sides of paper from the LAN-Fax driver, saving

• paper.

• ■ Simultaneous Save: Users can save the fax document as a TIFF file directly to a designated folder on their PC

• while the system is sending the fax in one operation.

• ■ Wireless Faxing: If the Aficio MP 6001/MP 7001/MP 8001/MP 9001 Series is connected to the network via the

• Wireless LAN option, faxing from the desktop can still be performed.

• ■ Fax Forwarding via Email: In addition to the inbound paperless fax to SAF/HDD, the Aficio MP 6001/MP 7001/

• MP 8001/MP 9001 Series’ have the ability to forward all incoming faxes directly to an administrator’s email

• address or folder, or you can program the Aficio MP 6001/MP 7001/MP 8001/MP 9001 Series to forward faxes

• from specific senders directly to designated receivers. Fax users can receive fax documents anywhere, anytime, 
as long as a PC and Internet infrastructure are available.

• Note: To enable LAN Fax capability, the Printer/Scanner Unit Type 9001 must be installed (standard on SP 
models) in addition to the

• Fax Option Type 9001. LAN Fax software is available with the Printer/Scanner Unit Type 9001 and standard with 
the SP versions of the

• main units.


